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ABSTRACT

Digital Illustration: The Costume Designer’s Process For
East Tennessee State University’s Spring Dance Concert 2012
by
Christine M. Waxstein

This paper’s objective is to document the research and developmental processes of creating East
Tennessee State University's Spring Dance Concert 2012 costume designs and renderings. This
thesis describes design creation from research stage to idea formulation to the conception of
costumes using inspirational images, illustrations, and performance photos and videos. The show
was a challenging undertaking because it involved the collaboration of many in a compressed
timeframe: 1 artistic director, 9 choreographers, 20 dances, 46 performers, 10 lighting designers,
1 costume designer, and 3 weeks to put it all together. Incorporating digital technology into the
rendering process saved time, expenses, and helped clarify the designer’s choices. This paper
reflects the 2-year study of incorporating digital technology into the rendering process,
culminating in the costume design for the Spring Dance Concert 2012.
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CHAPTER 1
INTRODUCTION
Design Background

I spent 2 years as a graduate student (January 2011 to December 2012) in the Master of
Arts in Professional Communication Degree Program within the Department of Communication
at East Tennessee State University (ETSU). During that time I intensely explored using computer
software as a means to create digital costume renderings for several theatrical and dance
productions at ETSU. As a result of this exploration, I found that the integration of technology
into costume design rendering offers more benefits than drawbacks when compared to the
traditional rendering method of hand sketching and watercolor. I prefer rendering on a computer
rather than hand sketching because seeing my ideas laid out on a converted image of the
performer on my own computer screen helps to clarify the design for me throughout the process.

The Advantages of Digital Software
Using a digital software program such as Adobe Photoshop to create costume and
makeup renderings allows designers to foresee potential issues with each design early on rather
than after a majority of the work has been completed. For instance, there may be a problem with
the shape of a dress looking unflattering on the performer, see Figures 1a & 1b. This can become
a serious issue if realized too late. Ideally the designer should be able to catch this possible
mishap during the rendering phase of the design process. Or, another typical drawback happens
when using the traditional rendering method of hand sketching while trying to depict human
figure proportions in accurate and convincing ways. When using traditional processes often the
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figure is purposefully elongated in order to better show off the costume and to look more visually
appealing. But, when using a photograph of the performer that is then transformed into a
computerized illustration through Adobe Photoshop, the designer is working with more accurate
proportions. It is certainly very helpful for the designer to be able to see what the clothing will
look like on the actor’s actual body while creating the design. It helps the processes of drawing,
designing, and making choices—and this is all possible using specialized techniques in Adobe
Photoshop. Using technology in this way is especially helpful in situations where the performer
is not available for fitting appointments; for instance, when she or he is located in another city or
state. In this situation the designer can have someone near the actor take photographs of the
performer, email them, and then the designer can create the renderings virtually by “trying on”
the costume using both the actor’s photograph and specialized software techniques. Therefore,
when the dress is added to the digital rendering any problems are visible at the start of the design
process potentially saving both time and money.
Aside from assisting the designer, digital renderings can also help in anticipating
potential issues relating to a director’s vision for the project. For example, maybe the director
thought a specific pattern on a dress would work for a character until she or he saw it on the actor
during the first dress rehearsal. In order to please the director and correct the visual offense, the
designer must start over and then has a matter of days or even hours to find a new costume.
When using digital rendering techniques, this situation can be avoided. By showing the director
the result on that specific actor earlier in the production process, the designer can circumvent any
problems early enough to affect reasonable solutions, see Figures 1a & 1b.
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Figure 1a – Multicolored Print Dress by
designer Alexander McQueen. American
actress Camilla Belle arrives at the premiere
of the motion picture Push, Mann Theater,
Westwood, Los Angeles, California: January
29, 2009. Photo credit: Anthony Citrano.
Source:http://commons.wikimedia.org/wiki/
File:Camilla_Belle_2009.jpg

Figure 1b – Digital Rendering of Hannah
Hasch wearing the multicolored print dress
by designer Alexander McQueen. ©
Christine Waxstein 2012. The large, busy
print on the small framed performer is
disproportionate and unflattering.

The focus of my graduate study, incorporating technology into the design process, is
something that is uncommon in the current world of costume design. Many designers in other
areas of theatre, like scenic and lighting design, have updated their rendering techniques by using
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computer-aided design programs like Nemetschek Vectorworks and Stage Research’s Softplot
for technical drawing, light plotting, and 3D modeling. Also, there are designers in other related
fields, particularly those in the fashion industry, who more readily embrace technology using
design software like OptiTex 3D Runway Suite. It is a slow evolution though for theatrical
costume designers. Current rendering practices used by established professional costume
designers still rely heavily on traditional methods and sometimes overlook the possible
advantages technology can offer. The few that have incorporated digital design software
typically use Adobe Photoshop because it is readily available and it can be downloaded as a free
trial to start. This can be a great resource for teachers to demonstrate and for students to use in
the classroom. As the computer industry continues to make advancements in hardware and
software development, a broader audience is reached. More and more people begin to take notice
of the benefits of incorporating technology into daily practice. Software that was intended for the
purpose of photo editing for example, like Adobe Photoshop, is now being used within a
completely different field—theatrical costume design. Although not made with this industry in
mind, it has become one of the most valuable design programs that can be used in the costume
shop in my experience. In order to understand the benefits I discovered in using technology to
create renderings for the Spring Dance Concert 2012, it is important to first know how costume
designing really works.

The Costume Design Process
When designing costumes and makeup for a play normally the process begins with the
script. The initial reading of the script is devoted solely to understanding the first impression of
what the play is communicating—a vital step for the success of the production. I find it
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important to remember that my own first impression of the intended message and of the
characters, when reading any script, is equal to the audience’s first impression when viewing the
production. Keeping this thought in mind helps me strive for clarity and specificity in all of my
design choices. After the initial reading the designer then reads the script once more focusing on
the details such as time, date, place, and character descriptions. The designer then reads the script
again and again; often upwards of four to five times in order to develop a strong sense of the
characters and what they would wear within the given circumstances of the play. According to
Brewster and Shafer (2011) the given circumstances for costume designers are
the obvious and concrete requirements of the play and any information that is
easily detected and readily accessed while initially reading the script. This list of
givens can include the objectives [like] time, period, place, locale, theme, mood,
style, revealing character, and solving practical problems. But only what is
immediately obvious on the first reading. (p. 33)
The designer’s given circumstances, along with the director’s input and the production concept,
allow the costume designer to conceptualize the project early on—usually before the show is
even cast. The ultimate goal is to make a statement through each character’s wardrobe that leaves
the audience knowing what this person is like even before she or he delivers their first line. This
requires conducting extensive research on both the play and era in which the story is set.
However, this process of designing for a play is vastly different from designing for the world of
dance, when there is no script from which to draw inspiration.
When designing for dance the choreographer acts as the playwright by creating the story
with movement instead of words. Therefore, the analysis and research portion of the design is
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done in a completely different way. The design process for dance is greatly influenced by the
choreography and choice of music. When these are addressed along with the choreographer’s
storyline, the designer can then begin to conceptualize the costumes. The early developmental
stages of creating the designs include extensive researching, and it is incredibly important to find
inspirational photos to assist in brainstorming ideas. Once ideas are solidified the next stage in
the process is to then start on the design renderings. Traditionally, many costume designers are
trained to sketch a figure using the human form as a guide in order to have a proportional base on
which to create the designs. Then the artistic vision of the costume design is traditionally drawn
over top the initial figure sketch and once the drawing is complete it is finally water colored.
This must all be done in order to construct the garments. Huaixiang (2010) has a different way of
creating renderings for dance, “When designing costumes for musicals or dance plays, I
incorporate music and body rhythm to present the movement and flow of the body, and produce
a realistic impression of how the costumes fit and work with the body” (p. 170). This can be an
incredible challenge when figure drawing by hand. Huaixiang (2010) stresses the importance of
correctly locating the weight-supporting leg in relation to the body [as it] is the
key to balancing the body. Dance poses can be one-leg support or two-leg
support, but keep in mind that the center of gravity line is the guideline for
positioning the weight-supporting leg or legs. (p. 37)
This challenge can be negated in the digital rendering process by first photographing the
performer and then employing specialized software techniques. When creating the first stage
photos in the digital rendering process, the designer can pose each performer individually and
appropriately in order to portray not only the feeling or style of the dance but also the positions
that convey specific movements in the choreography.
17

It is important to embrace traditional design processes such as drawing with pencil and
paper; however, there are much more efficient means of communicating design ideas available
using current computer technologies. Of course when something is new or unfamiliar it takes
time to learn. Complicating such a simple method of sketching with paper and pencil by
throwing in a software program with hundreds of tools and options sounds to some like a
ridiculous notion. The mere mention of it can instantly scare some people off; however, those
who choose to move forward in learning even a small portion of Adobe Photoshop begin to
understand how useful a tool it can be. They may even find that integrating computer design
software into these procedures not only cuts down on the amount of time it takes to develop a
rendering, but the software techniques can also clarify the designer’s vision. In addition, the
human form is potentially more quickly and accurately rendered thereby minimizing human
error. As a result, the costume designer works with the director to focus more clearly on the
depiction of the character through the costume design rather than focusing on why in the drawing
a character’s foot may be out of proportion with her head.
Using technology allows for easier collaboration of ideas. Say, for instance, the director
loves the shirt within a design but disagrees with the color choice in the completed rendering. It
is very difficult to demonstrate changing the shirt color from blue to red with traditional
watercolor techniques. Alternately, when renderings are created using Adobe Photoshop,
changing the color of the shirt is as simple as three clicks of the mouse. Another positive
advantage in using computer software when creating costume renderings is instant availability.
Because the designs are being created and saved as computer files, sending them via email is
incredibly simple. There are no extra steps in the process like scanning the watercolor using an
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additional piece of equipment, saving it as a reduced size file format, and ensuring the
preservation of the originals. Huaixiang (2010) notes that
If you make a mistake or if the director doesn’t like the colors you painted on the
copy, you…make another copy of the original. Disadvantages are that copy
machines and printers cannot process heavyweight paper, so you will have to
paint on low quality paper. (p. 196)
In Photoshop, if you make a mistake there is no need to make a new copy and start again;
changes become simple and are far less time consuming. Not only that, but the designer would
not have to be physically present in order to work on a production. All communication could be
done electronically. These are all advantages I’ve discovered through trial and error while
practicing Photoshop techniques as they apply to costume design rendering. Even though I have
encountered very few industry professionals currently using computer software to create
renderings, I did meet two costume designers, Catherine Bradley and Rafael Jaen, whose digital
work inspired me significantly.
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CHAPTER 2
INSPIRATION TO GO DIGITAL
Catherine Bradley’s Method

In March 2011 I visited the United States Institute for Theatre Technology’s (USITT)
annual conference in Charlotte, NC where I met someone who would change the direction of my
work forever. Her name is Catherine Bradley and she is the costume professor and resident
designer for McGill University in Montreal, Quebec, Canada. While teaching her students in
2009 about creating costume design renderings, she began to notice the differing levels of
drawing skill among her students. This was highly evident when she recounted a time that she
brought a director in to choose a design to be produced for their upcoming production:
I assured my students that good ideas can be expressed in very modest drawings
and that our judgments about their work were based on the merits of the design
and not solely on the students’ artistic talent. This worked fairly well within the
context of our class, but occasionally, when a director was added to the mix the
costume designs favored by the director tended to be the drawings that were
beautifully illustrated, regardless of merit and feasibility. (Bradley, 2009a, p. 48)
In an effort to even out the playing field among her students and offer those who lacked
proficient drawing abilities an alternative way to accurately depict their designs, Bradley
developed a costume rendering method using Adobe Photoshop Creative Suite 2 (her
methodology is what ultimately led to my own modification of a step-by-step tutorial). Once
Bradley’s steps are mastered through practice in Photoshop, this process can be considered
quicker and more efficient than drawing the human form by hand using traditional methods. The
20

amount of time it takes to become comfortable working within the software varies by person;
some learn quickly while others require more repetition and practice. Nevertheless, the
commitment to the process of trial and error is the key. Ultimately one of the strongest benefits
of digital rendering is the ability to create a base sketch within a matter of minutes and use the
digital file over and over again for different costume designs for the same performer.
The steps in the Bradley process are as follows: She calls the actor in for a fitting
appointment, asks him or her to dress in all black, tight fitting clothes to show a clear outline of
the body, and then photographs him or her in front of a white backdrop using a digital camera.
She then uploads the photo to her computer and through a prescribed series of steps using the
tool options in Photoshop, she transforms the picture into a sketch, see Figure 2a.1 From there,
Bradley puts the line drawing on a measurement grid, or what she calls a technical sheet, see
Figure 2b. The actual measurements of the actor are used to scale the drawing to the grid
measurements on the technical sheet (one inch scale). This allows the design elements (such as
the length of a pant leg) to be measured directly off of the rendering. During the costume
construction phase, this feature can save time and cut down on confusion over the design. As
Bradley notes; “This allows the costume details to be specific enough that they can actually be
measured from the drawing [making] a complete information package for the [draper,] cutter or
wardrobe manager, allowing the technical team in the costume shop to spend time efficiently
creating exactly what the costume designer envisioned.” (Bradley, 2009b, Making a Costume
Technical Sheet section, para. 1). An additional advantage to using the actor’s photo as the base
on which to design is that the actor’s proportions are potentially more accurate when using this

For detailed instructions on how to do this line drawing, visit Bradley’s website at
http://digitalcostumeproject.mcgill.ca/OutlineGuide.pdf
1
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method. However, the accuracy of proportion is contingent entirely upon the angle used to create
the photograph. It is important to keep in mind that for the purpose of creating a digital rendering
photos can be distorted or inaccurate if the angle of the camera is anything other than a centered
“face to torso” arrangement. In order to avoid this pitfall, the designer must shoot each performer
straight on with the lens aimed at the center of the actor’s torso (I find it helpful to refer to this as
the belly-button bulls-eye when explaining this to students). As mentioned earlier, the resulting
photograph and drawing takes out the tendency to elongate the figure. Consequently it is
important to have the specific and appropriate actor for each photo and sketch. The actor’s
photos only need to be taken once and can be used again for future productions but only if his or
her appearance does not change in the interim. At this point in the process the creation of the
design happens, see Figures 2b & 2c.
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Figure 2a – Bradley Process Photo actor photo to Photoshop line drawing © Catherine Bradley,
2009. Source: http://digitalcostumeproject.mcgill.ca/Description.htm
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Figure 2b – Bradley Finished Rendering full rendering on costume technical sheet with swatched
fabric in the margin © Catherine Bradley, 2009. Source:
http://digitalcostumeproject.mcgill.ca/Description.htm
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Figure 2c – Bradley Finalized Costume performance photo of the finished costume. © Catherine
Bradley, 2009. Source: http://digitalcostumeproject.mcgill.ca/Description.htm
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In her method Bradley uses paint tools in Photoshop to color in the details of the person
and to actually draw in the design. Often the design is drawn with a computer mouse; however,
another popular option is to use a graphics tablet. The graphics tablet connects to the computer
and comes with a stylus pen so that the illustrator can draw onto the screen just as if she or he is
drawing with a pencil onto paper, see Figure 3a. This can be a great tool for those transitioning
from the paper and pencil method. Some computers also come with built in tablets in the screen
itself so that the illustration can be drawn at eye level, see Figure 3b.

Figure 3a – Graphics Tablet a graphics drawing tablet that connects to the computer. Wacom
Tablet with Pen, Intuos 3 A5 June 6, 2011. Photo credit: Tobias Rütten. Source:
http://commons.wikimedia.org/wiki/File:Wacom_graphics_tablet_and_pen.png
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Figure 3b – Computer Screen a computer screen with a built in tablet. Wacom Cintiq 21"
September 8, 2010. Photo credit: Anonymous http://www.wacom.com.au/files/u7/Cintiq_21Front_0.jpg. Source: http://commons.wikimedia.org/wiki/File:Cintiq_21-Front_0.jpg
Rafael Jaen’s Technique
I learned about graphics tablets and their usefulness for creating digital renderings from
another technology driven costume designer, Rafael Jaen. Jaen’s advanced skill in Adobe
Photoshop as well as his ability to find alternative uses of the program’s photo editing tools for
costume rendering techniques immensely broadened my abilities. I first met Jaen at that same
2011 USITT conference where I met Catherine Bradley. Jaen, costume design advisor and
design-tech faculty for Emerson College and resident costume designer for Emerson Stage in
Boston, Massachusetts, is also incredibly skilled in digital portfolio design. His book on the
subject called Developing and Maintaining a Design-Tech Portfolio: A Guide for Theatre, Film,
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&TV2 is the reason behind why we met. Jaen was presenting a workshop at the 2011 conference
on creating a digital portfolio and it was in that workshop that I first heard about a summer
symposium on learning digital rendering techniques in Photoshop for costume designers. I made
a point to talk to Jaen following his workshop in order to learn more regarding the mentioned
symposium. I found out that it was going to happen in just a few months (summer 2011) and was
being hosted at Southern Illinois University Edwardsville (SIUE).
I was elated to be given the opportunity to attend the symposium through graduate
funding at ETSU. I was even lucky enough to have two of my current professors from ETSU and
two of my past professors from Middle Tennessee State University (MTSU) attend. It was a life
changing 4 days for me that ultimately shaped the rest of my graduate experience at ETSU. I
learned an incredible amount from Jaen on how to make Photoshop work for costume designers,
from creating fabric patterns to adding dimension to the 2D images by adding in highlights and
shadows (the dodge and burn tools).3 Jaen, probably most significantly, encouraged me to
experiment with different options within the program as the possibilities to find something useful
were endless. I left the summer symposium feeling optimistic about my abilities to master the
software and put it to use for the upcoming production season. Through practice, exploration,
and trial and error I managed to combine what I learned from Bradley and Jaen and alter the
process to better fit my design rendering needs.

2

Jaen, R. (2006). Developing and Maintaining a Design-Tech Portfolio: A Guide for Theatre,
Film, & TV. Burlington, MA: Focal Press.
3
For detailed instructions on how to do these effects, visit Jaen’s YouTube channel at
https://www.youtube.com/user/JaenRafael/featured
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Adapting the Process
The techniques learned from these groundbreaking industry professionals allowed me the
opportunity to synthesize and develop the digital rendering process into something unique and
useful for my own design purposes. This study lasted over a 2-year period starting in the spring
of 2011 while working in the costume shop at East Tennessee State University (ETSU). The
research started by studying techniques of two technologically driven costume designers,
Bradley and Jaen, and ended with the translation of their techniques into my own unique designs
and rendering methods. I incorporated their respective step-by-step conversion processes of
changing photographs to illustrations using Adobe Photoshop and then altered their original
guidelines to better fit my own design needs. Consequently, I saved time in creating the digital
renderings thereby allowing more time to produce high quality costumes for the productions.

Example Costume Design and Rendering Method
Inspired by Bradley’s methods, I photographed the performers in ETSU’s Spring Dance
Concert 2012 using a digital camera and then manipulated those images using a newer and less
complicated version of the software program, Adobe Photoshop Elements 8. In comparing
Elements to Creative Suite 2, Elements has a reduced amount of features, but all the required
tools a costume designer practicing this methodology would use. For that reason it is simpler and
easier to learn - an important consideration for the novice Photoshop user. The updated
guidelines allowed me to make illustrations that reflect the proper dimensions of each dancer’s
face and body - an important factor in order to create, as Bradley (2009b) describes, “a drawing
that is perfectly proportioned allow[ing] the designer and the technical team to see how the
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garment will look on the actual actor before any money has been spent on human resources and
materials” (p. 1).
In order to create costume and makeup designs for the Spring Dance Concert 2012 that
complemented one another, I first researched and found an inspiration image for each dance, see
Figure 4a. For example, for the dance Low Viscosity the choreographer, Garryn Howard, and I
agreed upon the Black Moor Goldfish as an inspiration image because it offered the color palette
she was looking for to fit with the style of dance and music she was using. In creating the
costume renderings, I combined Bradley’s step-by-step guidelines with Jaen’s Photoshop tips
and tricks plus the new discoveries I found while exploring their techniques. My own process is
as follows4:


Step 1: take a digital photograph of the performer wearing tight black clothes up
against a white backdrop. Ask the performer to choose a pose that is either in the
dance or is reminiscent of the choreography from it, see Figure 4b.



Step 2: create the outlined figure drawing, see Figure 4c. Begin to add color and
prep the illustration for the design phase.



Step 3: select a base skin tone to fill in the figure. To choose an appropriate base
skin tone, take a close-up photograph of the performer and use the Eyedropper
tool to cherry pick his or her actual skin color, see Figure 4d.



Step 4: select another variation of the skin tone that is found within the same
family as the first and layer the color. This will add dimension to the performer’s
skin color making it appear more realistic. To that same effect, use the Burn and

4

For full step-by-step instructions on how to create digital renderings, see Appendix A.
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Dodge tools to add shadows and highlights. Use the original photograph of the
performer to reference areas where lighting naturally added highlights and
shadows to the face and body.


Step 5: begin the actual design phase of the digital rendering process;
methodically apply the hairstyle and the full costume to the illustration, see
Figures 4e & 4f.

For the Low Viscosity designs, I used images of the actual clothes I planned to purchase
for the show in the costume renderings. Creating renderings for these purchased costumes was
very useful to me because doing so enabled me to see the individual pieces paired together on the
actual performer and also helped me clarify my vision for the dance. Additionally, I was able to
see the styling combinations I planned for all dancers in Low Viscosity together as they would
appear on stage, see Figure 4g. This allowed me to make changes before I purchased and ordered
the items. As a result of completing the above procedures, I learned that technology can serve as
an incredibly useful tool in creating designs for both makeup and costume design.
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Figure 4a – Black Moor Goldfish served as the inspiration photo for makeup & costume designs
for dancer Garryn Howard in Low Viscosity, ETSU’s Spring Dance Concert 2012. September 22,
2007. Photo credit: KD Blackmore. Source:
http://commons.wikimedia.org/wiki/File:Black_Moor_Goldfish.jpg
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Figure 4b – Digital Photograph of dancer Garryn Howard posing for Low Viscosity, ETSU’s
Spring Dance Concert 2012. © Christine Waxstein.
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Figure 4c - Finished Figure Drawing of dancer Garryn Howard posing for Low Viscosity,
ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 4d – Close Up Photo of Garryn Howard. Use the Eyedropper tool to select the
performer’s actual skin tone color. 2012 © Christine Waxstein.
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Figure 4e – Hairstyle Application to the illustration using design inspiration photo. 2012 ©
Christine Waxstein. Inspiration photo source: http://jeseniasgoodiebag.com/2012/01/16/punkhair-the-half-shaved-look-and-copy-alternatives/
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Figure 4f – Final Rendering for dancer
Garryn Howard in Low Viscosity in ETSU’s
Spring Dance Concert 2012. © Christine
Waxstein.

Figure 4g – Performance Photo of dancer
Garryn Howard in Low Viscosity in ETSU’s
Spring Dance Concert 2012. Photo credit:
Brian Kaldenbach.
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Example Makeup Design and Rendering Method
Once the design for the costume is complete, I then focus on developing the makeup
design to go with it. In creating the face sketches for Low Viscosity I used steps similar to the
Bradley/Jaen inspired process of creating full body sketches; however, the photo I used for the
makeup was a close up of the performer’s face both in front and profile views, see Figure 5a. I
then made a contoured face map, a chart that outlines the features of the performer’s face, and
that chart became a blank canvas on which to construct the makeup design, see Figure 5b.
Additionally, I used images found through the Creative Commons search engine,5 which filters
public domain photos on Google Images, Flickr, and Wikimedia Commons to name a few, as
inspirations to design the makeup patterns (i.e. fish scales that replicate the Black Moor
Goldfish), see Figure 5c. I then used various tools within Photoshop to manipulate the images
into the actual makeup design, which was easily replicated during application by the production
crew, see Figures 5d – 5f.

5

http://search.creativecommons.org/
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Figure 5a - Digital Close Up Photographs in Front and Profile Views of dancer Garryn Howard
posing for Low Viscosity, ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 5b – Blank Chart used to create makeup designs for dancer Garryn Howard for Low
Viscosity in ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 5c – Fish Scales inspiration photo for makeup design of dancer Garryn Howard for Low
Viscosity in ETSU’s Spring Dance Concert 2012. The scales were transformed and used in the
actual makeup rendering design. June 27, 2007 Source: http://theartofnature.org/id20.html

Figure 5d – Completed Face Map makeup design for dancer Garryn Howard for Low Viscosity in
ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 5e – Final Performance Makeup for dancer Garryn Howard for Low Viscosity in ETSU’s
Spring Dance Concert 2012. © Christine Waxstein.

Figure 5f – Video Performance of Low Viscosity in ETSU’s Spring Dance Concert 2012.
Choreographer: Garryn Howard. Dancers: Brock Cooley, Savannah Arwood, Maggi Hines, Josh
Holley, Garryn Howard, Hunter Smith. Video credit: Molly Davis.
https://www.youtube.com/watch?v=J3m5RLPrWnw
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CHAPTER 3
FROM THE COMPUTER SCREEN TO THE PERFORMANCE

Any great designer understands fully the performance aspects of a production. It is with
that understanding that she or he is able to create a vision and execute it into a medium for others
to observe. I am inspired by artists as I watch them perform. I like to assist in helping elevate
their performance, and often these artists can have a strong influence over the direction of my
designs. Their insights into the character can strengthen, or sometimes unfortunately hinder, the
choreographer’s vision and it is imperative as a designer to keep that in mind. A production is
only as successful as the team working behind the scenes and if every player is not working
toward the same goal, the intended message can become lost.

The Director’s Central Visual Image
Ultimately, everything comes down to the director’s central visual image for the
production that shapes all design ideas. Brewster and Shafer (2011) define visual image as
“…used to invoke a mood or theme. Designers use purposeful and significant visual imagery to
help express conceptual ideas and ultimately larger emotional and thematic issues found in the
play” (p. 251). The design aspects of any production help narrate how the storyline unfolds and it
is all about the story. It is the designer’s job to help the audience along by providing visual aids
and to assist the other artists (director, performers) in the journey.
Cara Harker was the director for the Spring Dance Concert 2012. She describes the
central visual image for the show as:
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I was hoping to find a common thread between the dances, so I said to the
choreographers... I'm going to give you a word that I hope will inspire your dance
in some way. And that word is... Water. I wanted to see if the various dances
could relate to one another without stifling choreographers by placing too many
restrictions on their creative process. I wanted them to feel free to make choices.
Ultimately some dances had the word water in the title, other dances had waterlike movement, while the subject of other dances was water. Through the efforts
of the choreographers, costume designer, Christine Waxstein and the head
lighting designer, Melissa Shafer, a unified look and feel to the concert was
achieved. (personal communication, Harker, 2012)
Jen Kintner, choreographer and Mountain Movers dance Company Director, described her part
of the concert further in saying that “each piece has an internal consideration of everything from
the physics and material properties of water, the feeling of it on your skin, or how it feels to roll
inside an ocean wave” (Contributed, 2012, para. 2). The nine choreographers, given the freedom
to explore the visual inspiration of water, came up with different interpretations in each of their
pieces - snow, dehydration (or lack of water), the ocean, and alcohol to name a few. It was a
difficult design challenge to create a common costuming thread for a concert that featured hiphop, jazz, ballet, tango, ballroom, lyrical, and aerial – silks and trapeze, varying interpretations of
the integration of water, and nine individual choreographer’s visions for the styling for their
dances. There was also the difficult task of bearing in mind the director’s lineup of the dances as
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there were several dancers who were cast in multiple pieces6. Therefore, consideration for their
costume and makeup changing times needed to be taken into account for the designs as well.
Finding the common thread amid 20 different dances that were completely dissimilar in
style was ultimately achieved through fabric and color choices. I used a myriad of reflective
fabrics throughout the concert to give the impression of wetness, see Figure 6a. This
strengthened the overall connection to water from start to finish.

Figure 6a – Reflective Fabrics used in ETSU’s Spring Dance Concert 2012. © Christine
Waxstein. Blue/Green sequined toile fabric from Reflection, White and Silver tutu sequined skirt
from Memories Made in the Coldest Winter, Baby Blue and Pink reflective fabrics from Water
Music, and Navy sequined with purple water colored overlay from Waters.

6

See Appendix B for program lineup
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Make It Rain (or Dehydration)
Inspired by the dances, and after making the decision that the color and fabric choices
would serve as unifiers for all designs, I began researching all aspects relating to water: the
molecular properties of water, plant life that grows within the ocean, marine life with great
colors and patterns, and what happens to life forms that are denied such a vital substance, to
name a few. An example of the latter was a dance called Make It Rain (or Dehydration)
choreographed by Everett Tarlton. The concept of the dance was of a West African tribe of
women enduring a drought and desperate from their dehydration embarking on a mystical rain
dance in order to end their own suffering. I began my research focusing on West Africa and the
different tribes and textiles within that region. That led me to learning about the Fulani tribe who
are the largest nomadic tribe in the world. Tarlton was looking for uniformity among the dancers
and was not striving for a realistic representation of the West African tribe but rather a few
suggestive elements that hinted at a geographic location.
In my research I also learned about different African fabrics and textile art. In particular I
looked at mud cloth which is a cotton fabric that is made using traditional hand-looms, see
Figure 6b. The fabric is often hand painted with symbols that are made into patterns representing
different meanings. I decided to choose a pattern that included the Iguana's Elbow symbol that
represents good fortune and the theory that an iguana can lead a hunter to water – seemingly
appropriate for a rain dance, see Figure 6c. I wanted to make sure we added in an interpretation
of jewelry that hinted at the Fulani tribe inspiration and Tarlton and I agreed that the costumes
needed to be representative of both contemporary Western European and traditional West
African cultures. There was the added challenge of the practical need for freedom of movement
by the dancers. We agreed upon a fusion of Western European style, found in the modern cut and
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materials of the outfit, mixed with West African influence present in the mud cloth style
patterning in the top and a black sequined arm band for each of the dancers, see Figures 6d – 6h.

Figure 6b – Traditional Mud Cloth Fabric. August 4, 2006. Photo credit: Malidirect. Source:
http://commons.wikimedia.org/wiki/File:Traditional_mud_cloth.jpg
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Figure 6c – The Iguana’s Elbow a traditional Fulani mud cloth symbol representing good
fortune. It also represents the theory that an iguana can lead a hunter to water. 45th Annual
Smithsonian Folklife Festival . National Mall, Washington DC. July 10, 2011. Photo credit:
Elvert Barnes. Source:
http://www.flickr.com/photos/perspective/5961713782/sizes/l/in/photostream/

Figure 6d – Make It Rain (or Dehydration) Tops the rust colored, mudcloth inspired printed tops
from ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 6e – Final Rendering of Dancer
Jessica Vest for Make It Rain (or
Dehydration)in ETSU’s Spring Dance
Concert 2012. © Christine Waxstein

Figure 6f - Final Rendering of Dancer Kayla
Harless for Make It Rain (or Dehydration)in
ETSU’s Spring Dance Concert 2012. ©
Christine Waxstein
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Figure 6g – Performance Photo of Make It Rain (or Dehydration) in ETSU’s Spring Dance
Concert 2012 displaying a fusion of contemporary Western European and traditional West
African styles; Choreographer: Everett Tarlton. Dancers: Kayla Harless, Katrina Kaldenbach,
Danielle Mumpower, Jessica Vest. Photo credit: Brian Kaldenbach

Figure 6h – Video Performance of Make It Rain (or Dehydration) in ETSU’s Spring Dance
Concert 2012. Choreographer: Everett Tarlton. Dancers: Kayla Harless, Chelsea Kinser, Katrina
Kaldenbach, Danielle Mumpower, Everett Tarlton, Jessica Vest. Video credit: Molly Davis.
https://www.youtube.com/watch?v=9ktInsiMfqg
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Don’t F*** With My Flow
Researching the choreographer’s inspirations also played a significant role in connecting
the different dances together. It was important to find some way to bring their ideas back to the
overall unifying image of water. Take for example a Hip-Hop dance that was part of the Spring
Dance Concert 2012 titled Don’t F*** With My Flow choreographed by Everett Tarlton. Tarlton
described the dance as:
Don’t F*** With My Flow explores the idea that a single seed of negativity
(when properly watered) can grow into total destruction. The dance begins with a
sequence of movements in a line. Dancers start to bump into each other, creating
animosity and anger between them. This frustration continues to grow, and some
attempt to alleviate the situation, which proves fruitless. Fighting ensues. A war
occurs and protesters arise. The world becomes a dumping ground for the waste
their negativity brings. The pressure and anger grows into a nuclear explosion,
leaving everyone dead at the end. (personal communication, January 25, 2012)
In analyzing Tarlton’s storyline, seeing the choreography he implemented, and researching
features relating to water, I found a creative connection in using fluorescent GloFish as the
inspiration for the costume design, see Figure 7a. The erratic behavior of GloFish when put into
a tank together are reminiscent of the action Tarlton describes in this quote. Ultimately, this idea
translated well for both the style of clothing, the spirit of the choreography, and the water image,
see Figures 7b – 7e.
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Figure 7a - Fluorescent GloFish which served as the design inspiration for Don’t F*** With My
Flow. Video in public domain, credit: http://www.glofish.com/ Sources: http://www.glofish.com
/video.asp and http://www.youtube.com/watch?v=YSkRz0O9ZJ0
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Figure 7b – Final Rendering of Dancer
Everett Tarlton for Don’t F*** With My
Flow in ETSU’s Spring Dance Concert
2012. © Christine Waxstein

Figure 7c - Final Rendering of Dancer
Lauren Dean for Don’t F*** With My Flow
in ETSU’s Spring Dance Concert 2012. ©
Christine Waxstein
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Figure 7d – Performance Photo of Don’t F*** With My Flow in ETSU’s Spring Dance Concert
2012. Choreographer: Everett Tarlton. Dancers: Brock Cooley, Lauren Dean, Mary Gass, Kayla
Harless, Maggi Hines, Mindy Nussman, Teague Quillen, Everett Tarlton. Photo credit: Larry
Smith, ETSU Photo Lab.

Figure 7e – Video Performance of Don’t F*** With My Flow in ETSU’s Spring Dance Concert
2012. Choreographer: Everett Tarlton. Dancers: Brock Cooley, Lauren Dean, Mary Gass, Kayla
Harless, Maggi Hines, Mindy Nussman, Teague Quillen, Everett Tarlton. Video credit: Molly
Davis. https://www.youtube.com/watch?v=XFzk_2UGuig
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Too Late to Tango
Inspirational images can also lead to interesting ways for the designer to convey the style
of the dance when the curtains first open. For instance, there was a tango dance that was part of
the Spring Dance Concert 2012 titled Too Late to Tango choreographed by Fernando Moraga.
The movement in the dance was graceful and breathtaking to watch. At the same time there was
an added element of excitement and a sense of danger in the hard hitting moves representative of
a classic tango dance. In pursuit of research photographs to help find a connection between the
style of dance and the water image, I came across this image of jellyfish, see Figure 8a. I had an
instant response to the connection between the impression the choreography left on me and the
mix of grace and danger jellyfish are known to have. I equally loved the gradation of color, or
what is commonly referred to as ombre, and wanted to incorporate that into the dress design for
performer Cara Harker. I had the idea for Moraga’s costume to represent the ocean in a color
palette of grey and aqua blues, serving as a backdrop for the female dancer—which is often a
prominent situation in tango dances. I then created the design rendering that included these
desired elements, see Figure 8b, constructed the costume, see Figure 8c, and showcased the dress
in the final dance, see Figures 8d & 8e.
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Figure 8a – Jellyfish Inspiration Image for Too Late to Tango. Photo credit: William Rafti of the
William Rafti Institute. January 6, 2006. Source:
http://commons.wikimedia.org/wiki/File:Transparent_jellyfish_in_aquarium.jpg
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Figure 8b – Final Rendering of Dancer Cara Harker for Too Late to Tango. © Christine
Waxstein, 2012.
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Figure 8c – In Progress Tango Dress for Too Late to Tango. © Christine Waxstein, 2012.
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Figure 8d – Performance Photo for Too Late to Tango in ETSU’s Spring Dance Concert 2012.
Choreographer: Fernando Moraga. Dancers: Cara Harker, Fernando Moraga. Photo credit:
Kenton Hall.

Figure 8e – Video Performance of Too Late to Tango in ETSU’s Spring Dance Concert 2012.
Choreographer: Fernando Moraga. Dancers: Cara Harker, Fernando Moraga. Video credit: Molly
Davis. https://www.youtube.com/watch?v=YRLNsS-s46c
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Design Challenges
What makes a great designer is the ability to think both logically and creatively, which is
a rare attribute to possess. There is innate difficulty in thinking with both the left and right sides
of the brain, but the ability to negotiate between the two is the key to developing strong designs.
Designers must not only understand the logistics such as budgetary guidelines that surround
costuming a production but the emotional effects tied to color and fabric choices. They must take
detailed notes of required props vital to the production and also think about each character and
what they would have or use. There is the additional hurdle of collaborating with the other
members of the production team, their thoughts, opinions, and interpretations of the characters.
ETSU’s Spring Dance Concert 2012 was even more challenging in that we had one artistic
director overseeing nine choreographers who were creating 20 different dances.

Sea Change
When a choreographer so thoroughly describes the characters and what they feel they
should be wearing, the designer is left with what seems like little room for creative input. The
challenge is then for the designer to reconcile their ideas with those of the choreographer. This
can be a difficult task if the choreographer’s vision is inconsistent with the director’s concept or
does not allow for a smooth transition from piece to piece. It then becomes the designer’s
challenge to find a compromise between all factors. This can be somewhat mitigated, though,
through the resourcefulness of an innovative costumer. For example, there was a dance called
Sea Change that was part of the Spring Dance Concert 2012. Choreographer Jen Kinter had a
very in depth storyline for her piece and with that, a strong idea for costumes. This dance in
particular presented many design challenges as it was an aerial silk performance piece
60

(acrobatics in mid-air performed on special fabrics) that also included floor work and partner
lifts. Kinter wanted to relate the dance specifically to the ocean,
I poured all the love I have of the ocean into my piece this year. All those days
playing in the waves, all the nights, walking along the shore, feeling my breath
synchronize with the waves, it’s all in there. My hope is that the piece awakens
people’s love of the big blue waves, the wonder of the ocean, the mystery and the
sheer power. (Contributed, 2012, para. 2)
In particular Kinter wanted the dance to portray an inspirational image she kept coming back to
while choreographing: seagrass, see Figure 9a.

Figure 9a – Seagrass Inspiration Image swaying green seagrass at the bottom of the ocean.
March 8, 2008. Photo credit: Ed Bierman. Source:
http://www.flickr.com/photos/edbierman/2789514285/sizes/z/in/photostream/

61

Kinter also described to the production team that she wanted the color of the aerial silks
to represent blades of the grass in shades of blue and green. I had the idea to costume the aerial
dancers as colorful fish that often inhabit seagrass. Wanting them to stand out even when they
are entwined by the silks, I thought to go with a color palette in complementary tones to the
colors of the silks: oranges, reds, and pinks, see Figure 9b. Only half of the dancers performed
aerial work as our theatre space could only accommodate three hanging silks. Kinter cast six
dancers, but wanted the primary focus to be on the three aerialists when they were on the silks
(the remaining three dancers did not leave the stage). And, to add an additional challenge, when
all the performers danced together on the floor Kinter wanted a cohesive appearance. The
choreographer’s requests prompted me to develop an overall look reminiscent of a school of fish
swimming through the seagrass silks. I designed the two groups of three in different color
combinations with aerial dancers in complementary colors and floor work dancers in seagrass
inspired colors., see Figure 9c.
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Figure 9b – Complimentary Color Palette a spotted sea horse swimming through seagrass in the
ocean, design inspiration for Sea Change. Sea horse in the sea grass... August 20, 2009 in New
Monterey, Monterey, CA. Photo credit: Bill Abbott. Source:
http://www.flickr.com/photos/wbaiv/5383682364/sizes/l/in/photostream/
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Figure 9c – First Sea Change Renderings dancers Jessica Vest and Caitlin Gawne pose for the
original Sea Change costume renderings showing the tail-fin inspired skirts, aerial dancers in
pink/purple and floor work dancers in blue/green. ETSU’s Spring Dance Concert 2012. ©
Christine Waxstein.
Kinter liked the idea of differentiating between the two groups of dancers (aerialists and
floor dancers); however, additional challenges have to be considered when designing for aerial
performances. Unfortunately, we discovered that the tail fin inspired multi-colored skirts would
not work because the dancers had extreme difficulties wrapping the silks around their bodies
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while wearing the skirts. Therefore, I went back to the drawing board and came up with a new
set of designs, see Figure 9d.

Figure 9d - Second Sea Change Renderings dancers Jessica Vest and Caitlin Gawne pose for the
2nd version of the Sea Change costume renderings, aerial dancers in pink/purple and floor work
dancers in blue/green. ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
In bringing the second set of design renderings to the choreographer, my new designs showed
several changes with the performers’ aerial movements in mind. Applying the digital rendering
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techniques made the idea switches much easier to communicate. Kinter agreed that these new
costumes would work on the silks; however, she was now rethinking the idea of separating the
dancers into two color groups. As we began to brainstorm new ideas, she mentioned a dance that
I had designed the previous year called Ambient wherein I hand dyed different types of fabric for
each costume, see Figure 9e.

Figure 9e – Hand Dyed Ambient Costumes from ETSU’s Spring Dance Concert 2011 used as a
technique inspiration for Sea Change. Dancers: Sunshine Marion, Danielle Mumpower, Kristen
Odom. Photo credit: Larry Smith, ETSU Photo Lab.
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As we discussed the Ambient costumes further, I tried to explain that there was not much time to
create these costumes and that repeating a costume design idea from last year was not ideal as
the two concerts had completely different central visual images. Despite the laundry list of
reasons given, Kintner became more and more attached to hand dyeing the costumes for Sea
Change. Therefore, I went back to the drawing board.
I decided to go back and research seagrass some more to find inspiration. I happened
across a photograph that sparked a new design idea, see Figures 9f & 9g. These photos show
camouflaged fish hiding in the blades of the seagrass as a defense mechanism against
predators—very different from the idea that the fish should boldly contrast with the seagrass
silks. I began to mull this idea over and liked that these inspiration photos were the same colors
as both the silks being used in the dance and the colors in the lightning design. I remembered that
Kintner wanted this piece to above all else represent the ocean. One of the most substantial facts
about underwater life is the natural food chain that exists. A large reason for the specific color
and patterning found on fish and other aquatic creatures is for self-protection—so they can blend
into their surroundings when being preyed upon.
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Figure 9f – Camouflaged Green Fish seagrass in shades of lemony green with camouflaged fish
swimming throughout. Likely Seagrass Razorfish (Initial Phase) March 1, 2012 in Bacong,
Central Visayas, PH. Photo credit: Elias Levy. Source:
http://www.flickr.com/photos/elevy/6851434172/sizes/l/in/photostream/
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Figure 9g – Camouflaged Blue Fish seagrass in shades of turquoise blue with camouflaged fish
swimming throughout. Lionfish hiding in sea grass May 3, 2009 in Al Bahr al Ahmar, EG. Photo
credit: Matt Kieffer. Source:
http://www.flickr.com/photos/mattkieffer/3642464000/sizes/l/in/photostream/
For a third time I went back to the drawing board, or in this case back to Photoshop. I
quickly altered the renderings to reflect the hand dyed fabric technique. This turned out to be a
simple task as I already had the base illustration on which to create the new costume designs, see
Figure 9h. Once given approval from the director and the choreographer, I then began work on
hand dyeing white spandex, polyester, and cotton blend leotards, see Figure 9i. The final
costumes for the performance ended up being a fantastic translation of camouflaged fish
swimming through the seagrass on the ocean floor, see Figures 9j & 9k. The digital rendering
technology saved me time when needing to change the costume designs while collaborating with
the choreographer. The finial costumes, as shown in Figures 9j & 9k, were cohesive to the needs
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of the performers, the requests of the choreographer, and the connection to the central visual
image of the dance concert.

Figure 9h - Third Sea Change Renderings dancers Jessica Vest and Caitlin Gawne pose for the
3rd version of the Sea Change costume renderings, aerial dancers in shades of lemony green and
floor work dancers in shades of turquoise blue. ETSU’s Spring Dance Concert 2012. ©
Christine Waxstein.
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Figure 9i – Hand Dyeing Technique on white leotards in shades of lemony green and turquoise
blue for Sea Change in ETSU’s Spring Dance Concert 2012. © Christine Waxstein.
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Figure 9j – Performance Photo of Sea Change in ETSU’s Spring Dance Concert 2012.
Choreographer: Jen Kintner. Dancers: Caitlin Gawne, Katrina Kaldenbach, Jen Kintner, Jenna
Middlebrooks, Jessica Vest. Photo credit: Larry Smith, ETSU Photo Lab.

Figure 9k – Video performance of Sea Change in ETSU’s Spring Dance Concert 2012.
Choreographer: Jen Kintner. Dancers: Caitlin Gawne, Katrina Kaldenbach, Jen Kintner, Jenna
Middlebrooks, Jessica Vest. Video credit: Molly Davis.
https://www.youtube.com/watch?v=_kwAkMpv4kE
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CHAPTER 4
CONCLUSION

By using modern technology, the costume designer can enhance the design process by
accurately depicting the design on the performer thereby allowing for better visual
communication among all of the artistic team. In our current computer age, electronic sketches
are great communication tools for showing design concepts and ideas to other people involved in
the production. Instead of having to set up face-to-face meetings for simple questions, the
designer can simply send an e-mail with the renderings included. Employing Adobe Photoshop
in the costume design process allows the designer to foresee potential issues before additional
work occurs as shown in Figures 1a and 1b in Chapter 1. Using technology allows for the correct
proportions to be illustrated and an accurate portrayal of the performer makes replication of the
design more efficient as found in the makeup application of Low Viscosity discussed in Chapter
2. This can be an incredibly valuable tool when testing out design ideas as evidenced in the Sea
Change design process described in Chapter 3. Simple changes can be made to a Photoshop file
and different versions of the design can be easily saved without losing any previous work.
Variations to the design are quick and can be helpful in meetings with the director or
choreographer. Photoshop can also be used to create “virtual fittings” which can be beneficial
when designing at a distance. Additionally, communication of the design to the director, fellow
designers, and production crew is potentially more clear and effective.
There are two innovative costume designers whose work in Adobe Photoshop had a great
impact on my design process. Catherine Bradley and Rafael Jaen taught me the basics of digital
rendering and encouraged me to explore new methods for designing within the program.
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Through trial and error I was able to expand on their guidelines and adapt them to better fit my
design needs as explained in Chapter 2 using the renderings from Low Viscosity. I faced several
design challenges during East Tennessee State University’s Spring Dance Concert 2012 but was
able to overcome most of them by putting to use skills I learned in Photoshop. The overall design
for the concert was successful in communicating the artistic director’s central image of water
through the fabric and color choices as well as through the inspirational images behind the
design. This was shown through the dances Make It Rain (or Dehydration), Don’t F*** With My
Flow, and Too Late to Tango from Chapter 3. Most importantly, however, I strived to create
work to be proud of and these techniques learned from industry professionals helped me to do
just that.

For Further Research
In the future, I want to advance the process by using 3D software like Open-Source’s
Blender, which is free to download the full program. This approach would allow the designer to
create a 360° view of the costume design while still using the performer’s correct and accurate
proportions. The designer then would only need to make one file to show the entire costume
front, sides, and back, whereas to achieve a 360° view in Photoshop designers must create
separate front, profile, and back images. When showing a 3D illustration to directors, designers
would be able to efficiently discuss all aspects of the design without transition between files.
And because the 3D image is a step closer to reality, directors will be more receptive to the
information communicated there.
In addition to developing costume rendering methods in 3D, I am also interested in
setting-up an automate repetitive task action that would process step-by-step guidelines in
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Photoshop. In this process steps for making the sketch effect are recorded as they are applied in
Photoshop. This recorded action can then be used to automate the process of converting other
photos in the same manner. This task will automatically take any digital photograph through the
outlined steps in Chapter 2 of this thesis, thereby making the process speedy and simple. The
new action, which can be labeled “figure drawing”, works as a template of instructions allowing
the software to implement specified actions on to the image. For the busy costume designer this
can be a task delegated to students or design assistants saving time in the overall design process.
Additionally, I would like to explore creating original pattern designs in Photoshop and
then sending them out to be printed onto actual fabric, or what is called digital textile printing—
sometimes referred to as Direct to Garment or DTG for short. This is the emerging process that is
beginning to replace sublimation. Sublimation consists of printing the digital file image on to a
large roll of transfer paper and then running that overtop the fabric through a heating press.
Digital textile printing currently uses a large dye-sublimation printer with sublimation inks to
print directly onto the fabric. Most digital media departments at universities have machines
capable of doing this already. My goal is to create fabric designs in Photoshop that are show
specific that can easily be transferred to fabric and then on to the stage. As with technology’s
ever changing landscape, my research interests will evolve. The fact that it is constantly
changing, I find, is a positive thing and an aspect to be embraced.
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APPENDICES
APPENDIX A: Step-by-Step Photoshop Instructions

Christine Waxstein’s process:

1. First, take a digital photograph of the performer wearing tight black clothes up against a
white backdrop. Ask him or her to choose a pose in the dance or reminiscent of the
choreography from it.
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2. Then open the file in Adobe Photoshop Elements 8 and immediately double click on the
Background title to rename it Layer 0 – this unlocks that layer that is useful when
switching between the multiple layers you will create.

3. From there, select from the top menu: Filter > Noise > Reduce Noise. A new window
will pop-up with a zoomed in view of the photograph.
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a. Here enter in the values Strength: 6, Preserve Detail: 60, and Reduce Color Noise:
100 and hit OK – this will clean up the image slightly so that the lines are easier
to define when it is transformed into a figure drawing.

4. Next click on the Quick Selection Tool and hit the Add to selection icon.
5. From here, click around the area you would like to keep (the performer) and, while
holding down the mouse button, drag the add to icon around until the entire body is filled
– the moving dotted line is called marching ants, they indicate what has been selected.
6. Then check to make sure you did not miss a section you want to keep for the rendering. If
you over shot the dragged area and need to deselect, click the Subtract from selection
icon located to the right.
7. Next, choose from the top menu Select > Inverse – this will reverse what is selected as
Add to and what is Subtract from.
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8. Then hit Delete to get rid of the background and make the rest of the layer transparent. To
get rid of the marching ants, click on Select > Deselect from the top menu.
9. Then use the Crop tool to narrow in on the image, pressing the green check mark once
you have outlined where the crop will occur.

10. Next select Enhance > Adjust Lighting > Levels from the top menu to adjust the lighting
levels of the photo.
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a. From here, click on the adjustment triangles under Input Levels. Moving the
mouse left or right will either increase or decrease the effect. This is measured by
personal taste and the numbers vary depending on the photo. The goal here is to
adjust the lighting frequencies so that the details will show once the figure is
outlined.

11. Then hit Filter > Sketch > Photocopy – this is the step where the photograph is
transformed into an illustration.
a. A pop-up window will appear. This is the Filter Gallery and you will see that the
Photocopy filter is selected.
b. The first thing to do is adjust the percentage of the view to Fit on Screen that will
allow you to see the entire image in the preview window.
c. Move the Detail and Darkness sliders to find the correct balance to outline the
figure. This also varies depending on the photograph. It is important to make sure
the adjustments retain the facial details of the performer. The final rendering will
suffer if those are lost in this stage of the process.
d. Click on OK once the outline is at the correct balance.
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12. Most often spotting will occur on the outlined figure. In that case, use the Paint Brush
tool in the pure white color to “erase” unwanted detailing.
a. Zoom in or out to better see the areas to fix. This is where unwanted “leakage”
breaks can be found, as Jaen termed. “Leakage” refers to a disconnected line in
the drawing that leaves an open space for color to seep out onto the background.
b. There is a simple solution to this problem however. Change the Paint Brush color
selection to black and go over the open area sealing the gap between the outline.
You will find that a basic round brush in size 4 usually matches the thickness of
the outline well. Continue painting in white and fixing “leakage” areas in black
until the entire body has been modified.
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13. Begin to add color and prep the illustration for the design phase. The first thing to do at
this point in the process is select a base skin tone to fill in the figure.
a. To do this, click on the top paint square (foreground color) located in the lower
left hand corner of the Tools Bar. It is standard when the program opens for the
foreground color to be black and the background color to be white, this is the
default. The order can be easily reversed by clicking on the 90 degree arrow
above the squares.
b. Click on either square, the Color Picker pop-up window will open. To choose an
appropriate base skin tone, it is helpful to open one of the close-up shots of the
performer and use the Eyedropper tool to cherry pick his or her actual skin color.
c. From here, click on the Paint Bucket tool and lower the Opacity setting for the
color. This will soften the saturation of the skin tone when applied to the outlined
figure.
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14. Next, fill in the form by clicking the area you want to paint.
a. Sometimes there will be parts that do not fill in with the rest leaving a colorless
area. This is because the Paint Bucket fills in outlined shapes found within the
selection. What this means is that those parts that were not colored were
considered different shapes on the figure, ergo why “leakage” can become an
issue during this phase of the rendering process. All that is needed when this
happens is to fill in the colorless areas by clicking on them with the Paint Bucket
tool as well.
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15. Once the entire figure is colored, then select another variation of the skin tone that is
found within the same family as the first to add layers of skin coloring. Choose a
highlight color and a shadow color. This will add depth into the rendering making it
appear more realistic.
16. To that same effect, use the Burn and Dodge tools to add shadows and highlights. The
Burn tool is shaped like a white hand whereas the Dodge tool is a blue pin that is
accessed by right clicking on the default Burn button. Use the original photograph of the
performer to reference areas where lighting naturally added highlights and shadows to the
face and body.
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17. It is then time to begin the actual design phase of the digital rendering process (for the
design in this discussion, I used images of the actual clothes I planned on purchasing for
the show in the costume renderings).
18. The first step in the design stage is to apply the hair style to the illustration.
a. To do this, use the Quick Selection tool and drag the selected area onto the
illustration.
i. Then use Image > Transform > Free Transform | Skew | Distort |
Perspective options located at the top menu to alter the angles of the image
in order to create a better fit for the hair onto the performer in the
illustration.
ii. Use the same methodology to apply the top.
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19. Another useful way to fit the item onto the performer is to use the Quick Selection tool to
select part of the pants and drag that layer over to the illustration.
a. Then use the Quick Selection tool again to outline the area of the performer’s leg
while on Layer 0.
b. The pant portion layer, Layer 1, can be been hidden by clicking on the eye located
next to the layer tabs.
c. While still on Layer 0, unhide the pant portion layer, Layer 1, and then hit Select
> Inverse. This will, as before, change what is Add to and what is Subtract from.
d. Then click on the pant portion layer – Layer 1 and choose Edit > Delete filling in
that area of the leg with the pant portion.
e. Continue with this process each time selecting a different part of the pants and
dragging the selection over to the illustration – thereby creating several pant
portion layers.
20. Once they are all in place, I combine the layers by holding down the Control key and
selecting them all, and then right click to choose the Merge Layers option.
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21. You can at that point rename the layer Black Pants that helps in identifying when there
are several open layers.

At this point make minor adjustments wherever needed. Then save the completed rendering in
both psd and jpeg file formats (to get the beast quality jpeg, use Save for Web option).
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APPENDIX B: Spring Dance Concert 2012 Program

This is a scanned image of the program that shows all 20 dances by the nine
choreographers for the ETSU Division of Theatre and Dance Spring Dance Concert 2012. It also
demonstrates the difficulty in designing for 46 performers many of whom were cast in multiple
dances that left little time for costume changes.
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